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1. Introduction

This manual serves as an installation and user guide for the StAnD Meteor Camera Kit,
developed to automatically detect bright meteors (otherwise known as fireballs and/or
bolides) during night-time, if weather conditions are favourable.

The camera module used in the StAnD Meteor Camera Kit is an all-sky camera (see Figure 1),
i.e. it is able to capture the whole observable sky (down to ~10° above the local horizon) in a
single acquisition. This module is operated at 30 frames per second (fps) during night-time
by the mini-PC included in the kit. Data of meteor observations are automatically saved
when the system recognises the occurrence of a bright source moving within the camera’s
Field of View (FoV).

The data, configuration, and control of the StAnD Meteor Camera Kit are accessible through
standard SSH (Secure Shell Protocol) or through a browser interface, either locally or
remotely. The data acquired by the StAnD cameras are also shared among all the project
participants on a cloud service to enable the triangulation of the meteors observed by more
than one station of the network and to allow teachers and students from other schools to
join the StAnD project, even if they do not have access to a camera by themselves.

Finally, the data acquired by the StAnD Meteor Camera Kit can be analysed through a data
analysis tool (named PASCAL) provided with the kit. This tool enables visualizing and
exporting animations or timelapses of the data acquired by the camera, as well as
performing their scientific analysis. Its ultimate objectives are to unveil the origin of the
observed object within the Solar System and to determine if a fragment of it, i.e. a
meteorite, has survived the atmospheric flight and fallen to the ground.

The idea of the StAnD project originated from the experience of PRISMA (Prima Rete Italiana
per la Sorveglianza sistematica di Meteore e Atmosfera, i.e. First Italian Network for the
Systematic Surveillance of Meteors and the Atmosphere), a professional fireball network in
Italy operated by INAF, the Italian National Institute for Astrophysics. PRISMA is part of
FRIPON (Fireball Recovery and InterPlanetary Observation Network), an international
collaboration that involves many national meteor and fireball networks around Europe and
worldwide.

Figure 1 — The first all-sky camera of the PRISMA network in Italy, installed in 2016 on the roof of the office
building of the Astrophysical Observatory of Torino, part of INAF - the National Institute of Astrophysics.
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The following sections of this introduction provide a brief summary covering the topics of
meteoroids, meteors, and meteorites, as well as the methods used to observe meteors, with
a focus on the optical ones. For a complete overview of these topics, please refer to the
StAnD Teacher’s Manual.

1.1. Meteoroids, Meteors and Meteorites

Apart from our central star (the Sun), the eight major planets, and their satellites (like the
Moon) the Solar System is populated by a vast class of minor bodies (see Teacher’s Manual,
Chapters 3 and 4). Such bodies are usually classified according to their size:

e Predominantly round and large-sized objects orbiting around the Sun are called dwarf
planets. This is the case for 1 Ceres (see Figure 2, left panel), known as the first
discovered asteroid, which has a diameter of about 940 km.

e Irregularly shaped rocky bodies orbiting around the Sun (which are neither planets
nor dwarf planets) are called asteroids. One of today’s well-known asteroids is
101955 Bennu (see Figure 2, right panel), a “small” 480 m asteroid, visited by NASA's
sample-return mission OSIRIS-REx.

e Minor objects similar to asteroids but made of more fragile materials, such as ice and
dust, are called comets (see Figure 3). They are the most well-known objects because
they exhibit a tail of dust particles when approaching the Sun, which is sometimes
visible from the Earth.

e Objects that qualify as asteroids or comets but are smaller than 1 m are called
meteoroids. These objects are so small that ground-based telescopes cannot
systematically observe them, unless they are very close to the Earth. Meteoroids are
usually fragments of asteroids (or particles released from comets) that were ejected
from the parent asteroid after a collision with another object. Similarly, meteoroids
can also originate from major planets.

Figure 2 — The 3D models of 1 Ceres (left panel) and 101955 Bennu (right panel) based on direct observation
of these asteroids. Small asteroids and meteoroids can have very irregular shapes. They usually rotate around
their axis at fast rates (1 rotation every 4.3 hours in the case of Bennu). The effect of such fast rotation often
leads to top-shaped asteroids (like Bennu). Credits: NASA Visualisation Technology Applications and VTAD) -
link
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Figure 3 — The first direct image of the comet 1P/Halley, taken in 1986 by the European spacecraft Giotto. For
scale, the nucleus has an average diameter of ~11 km. Credits: Halley Multicolor Camera Team, Giotto Project,
ESA - link

Minor bodies orbit around the Sun on more (comets) or less (asteroids) eccentric orbits.
Most of the population of asteroids and meteoroids orbits within the Main Asteroid Belt,
between Mars and Jupiter. If their orbit is close to that of the Earth, they are called
Near-Earth Objects (NEOs; see Teacher’s Manual, Chapter 5.1).

Such objects may approach the Earth’s position and deviate from their original orbit, pulled
by the Earth’s gravitational attraction. In this case, the interaction between the meteoroid
and the Earth’s atmosphere produces a phenomenon called meteor. In specific terms, a
meteor is "[...] the light and associated physical phenomena (heat, shock, ionization), which
results from the high-speed entry of a solid object from space into a gaseous atmosphere",
according to the definition of the International Astronomical Union. The most evident
feature of a meteor is its light emission, which originates from the heating of the meteoroid
material and of the surrounding atmosphere mostly due to the high friction caused by the
supersonic atmospheric entry. Indeed, meteoroids from the Solar System can impact the
Earth’s atmosphere at speeds between 11 and 72 km/s, that is from 35 to 240 times the
speed of sound in air at standard temperature and pressure (see Teacher’s Manual, Chapter
5.2).

Meteors can have either an asteroidal or cometary origin. Since asteroids usually orbit
around the Sun with a prograde orbit (i.e. counterclockwise when viewed from above the
Sun, as all the major planets do), asteroidal meteors usually have a slower impact speed (11 -
40 km/s). On the contrary, since comets usually have a retrograde orbit (i.e. clockwise),
cometary meteors usually impact the Earth’s atmosphere at higher speeds (40 - 72 km/s).
Cometary meteors usually originate from meteoroid streams, produced by comets that
release particles along their orbit due to the effect of the solar wind, resulting in meteor
showers when the Earth crosses the comet’s orbit (see Teacher’s Manual, Chapter 5.3).
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Figure 4 — The first photograph of a meteor, taken on 27th November 1885 by the astronomer Ladislaus
Weinek in Prague. Credits: AMS - link

Further terminology is used in meteor science. A meteor that shines brighter than Venus (the
second brightest object in the night sky) is called a fireball. The meteoroid may also fragment
into several pieces during its atmospheric flight due to the very high pressure generated by
the hypersonic flight. Fireballs that exhibit fragmentation events are often called bolides.
These fragmentation events usually correspond to bright flashes (flares), and they release a
large quantity of meteoritic dust into the atmosphere, which slowly deposits downwards to
the Earth’s surface. Such um- to mm- sized particles can be recovered on the ground and are
called micrometeorites. They can also originate from very microscopic meteoroids (< 30 um
in size) that are also called Interplanetary Dust Particles (IDPs), which do not ignite as
meteors when impacting the Earth’s atmosphere.

On rare occasions, in about 0.1% of fireball events occurring on Earth, a small residue of the
meteoroid survives the atmospheric flight. The bright, visible phase of the meteor ends at an
altitude of about 20-30 km from the ground, and any surviving fragments eventually fall to
the ground after the so-called dark flight. These stones are called meteorites. The recovery
of meteorites and the analysis of their composition are fundamental to understand the
formation and evolution of both minor and major bodies, since they preserve pristine
samples from the early stages of the Solar System.

1.2. Observational Methods

The first scientific observation of a meteor dates back to 140 years ago (see Figure 4) and,
since then, systematic or sporadic observations of meteors have been carried out by both
the professional and amateur community of astronomers. To date, meteor observations are
the only way to probe the population of small-sized asteroids and meteoroids. Indeed, the
smallest asteroid ever detected through direct, ground-based telescopic observation is 2015
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TC25, with an estimated size of 2 m. However, this observation was possible only thanks to
its unusually high albedo (i.e. the fraction of sunlight that the asteroid surface is able to
reflect) of about 60%. Current estimations suggest that we have observed >90% of the NEO
population above 1 km in size. On the other hand, the population of small asteroids below
100 m is poorly constrained.

The most fruitful method to observe meteors is by optical observation, that is, detecting the
light emitted by the meteor with a telescope or a camera. Wide-field telescopes, and
especially all-sky cameras (see Figure 5), are preferred in this case in order to cover the
largest portion of the observable sky and maximize meteor detection efficiency, since
meteors not originating from known comets are sporadic events (i.e. the observer does not
know a priori when and where in the sky a meteor will occur).

All-sky cameras are typically built using commercially available camera modules equipped
with a fish-eye objective, able to capture the whole visible hemisphere. Such a result can be
obtained by distorting the FoV onto the focal plane of the camera in a circular image, where
the outer circumference corresponds to the local horizon.

Figure 5 — The functioning principle of all-sky cameras equipped with a fish-eye objective. A composite optic
system (left panel) focuses the light incident onto the outer lens towards the focal plane, introducing
significant distortion. The resulting image acquired by the camera is circular (right panel). Light rays coming
from the horizon are focused towards the outer edge of the image (red circle), while those coming from the
zenith direction are directed towards the centre of the image. Credits: (left) Frogget, B. C. et al, “A fisheye lens
as a photonic Doppler velocimetry probe”, Proceedings of SPIE, 2012 - link, (right) Avaruussaakeskus, RWC
Finland - link

Optical observations of meteors are carried out in two possible ways:

e Photographic observations: the objective is left open to incoming light for a certain
amount of time (from a few minutes up to the whole night, depending on the
instrument’s sensitivity). During the night, stars apparently rotate around the North
Pole and appear as circular star trails, while meteors and fireballs produce slanting,
straight, and bright strikes against the background of star trails. To obtain a relative
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indication of the time, such devices are usually equipped with a rotating shutter that
periodically obscures the objective, leaving equally spaced dark ticks along star trails
and meteor strikes. An example of photographic observation of a fireball is shown in
Figure 6.

Video observations: the camera performs short and consecutive acquisitions,
operating at high frame rates (30 - 60 fps) and capturing the image and motion of the
meteor at each instant, with an absolute time reference. Due to the short exposure
times, video observations are mostly used for the detection of fireballs and bolides.
On the other hand, high-sensitivity professional cameras must be used to capture
faint meteors by video observations.

Observations of meteors can be carried out on other channels as well. For example:

Radio: detecting radio waves (from military or communication infrastructures)
reflected by the plasma channel generated by the meteor.

Acoustic: detecting the shock waves generated by the meteor’s hypersonic motion,
either in the air (using infrasound detectors) or when impacting the Earth’s surface
(using seismic stations).

Spectroscopy: the intensity of light emitted by the meteor at different wavelengths
can unveil the meteoroid’s composition.

Figure 6 — Photograph of a fireball detected on 21 January 1999 by the Czech station No. 16 of the European
Fireball Network camera system. Star trails are visible as circular arcs centred on the North Pole. The bright
fireball crosses the star trails almost perpendicularly. Credits: ISSI Bern - link
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Figure 7 — The StAnD Meteor Camera Kit installed and displayed in the lecture room of the first StAnD
Summer School from 30 June to 5 July in Marathons, Greece. In this case, the camera module is installed on a
wooden support just for indoor display. Since no Ethernet wall plug was available in the room, the kit
network is connected to the Internet through a laptop’s Ethernet plug.
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2. StAnD Meteor Camera Kit

The StAnD Meteor Camera Kit is designed to autonomously monitor the night sky in order to
detect fireballs and bolides. The kit consists of three main components, depicted in Figure 7:

1) The control mini-PC: it controls the whole system through an open-source program
named FreeTure, a Free software to capTure meteors. This program operates the
camera, handles the data acquisition schedule during day and night and, most
importantly, runs the trigger for meteor data (the video stream acquired during
night-time at 30 fps) to recognize the passage of a fireball in the FoV of the camera. A
trigger is an algorithm that automatically checks for the occurrence of specific events
within a dataset. In this case, the algorithm checks for bright sources moving in a
straight line with a high angular speed, compatible with the speed range of meteors
in the Earth’s atmosphere (11 - 72 km/s; see Section 1.1). In such a case, FreeTure
saves a segment of the video stream (a few seconds before and after the fireball
detection) and marks this occurrence as a detection (i.e. the data of a fireball
captured by a single camera). It is connected to the other components and to the
Internet through an Ethernet cable linked to the network switch.

2) The all-sky camera: a PoE (Power over Ethernet) camera module coupled with a
fish-eye objective, enclosed in a passive-cooling case and exposed through a plastic
dome to protect the camera and optics. In its operational configuration, the camera is
installed on the roof / balcony of the building, through its mounting system. The
camera is connected to the whole system via a 5-m Ethernet cable (attached to the
case with a waterproof extender) and linked to the network switch, which also
provides power to the camera.

3) The network switch: a network hub that connects the whole system locally, providing
power to the camera and Internet access to the mini-PC. It is connected to the
Internet through an Ethernet cable plugged into the wall Ethernet socket, or directly
to the router. The data acquired by the kit are then handled by the INAF - PRISMA
servers.
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Figure 8 — Schematic representation of the StAnD Meteor Camera Kit. The light violet box encloses
components installed indoors, while components in the light blue box are installed outdoors (only the all-sky
camera). Ethernet cables are represented as single solid black lines and power cables as double solid black
lines. The system is connected to the Internet through the network switch, and data are synced and ingested
by the servers of the PRISMA fireball network (hosted at INAF - Osservatorio Astronomico di Trieste).
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Both the mini-PC and the network switch are connected through their own power supply
adapter to a wall power outlet, while the all-sky camera is powered through the switch by
PoE. The connection scheme is presented in Figure 8.

2.1. Hardware Description
The kit is assembled and shipped by N-3 srl.

A. All-sky Camera
The all-sky camera consists of several parts:
e The protective case and dome, produced by
Shelyak instruments (see Figure 9, left panel);
e The camera module - Lucid Visions Phoenix 3.2
MP (model PHX032S-MS), equipped with a Sony IMX265 CMOS sensor (see Figure 9,
central panel);

A
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o The fish-eye lens, model BQ1550B-12MP, with 1.55 mm focal length F2.8 (see Figure
9, right panel).

Figure 9 — The main components of the all-sky camera included in the StAnD Meteor Camera Kit. From left to

right: the protective case and plastic dome from Shelyak Instruments, the camera module Lucid Visions
Phoenix 3.2 MP and the fish-eye lens.

ok

B. Mounting System of the All-Sky Camera

The camera is provided with a mounting system made of stainless steel parts, which allows it
to be mounted on a level or inclined surface, on a wall, or on a pole, depending on the
configuration of the installation site. It is made of:

e A main body (a stainless steel flange; see Figure
10, top left panel) onto which the bottom of the
camera is screwed;

e Two side panels (two stainless steel parts; see
Figure 10, top central panel) that support the
main body;

e A pole mounting plate (see Figure 10, top right
panel) to be inserted under the two side panels if
the camera has to be mounted on a pole (not
recommended).

The system is complemented by the needed screws, two pole mounting rivets, a junction
box, and an ethernet RJ4 coupler (see Figure 11).

Figure 10 — 3D rendering of the main components of the mounting system for the all-sky camera. From left to
right: the main body (B1), two side panels (B2) and the pole mounting plate (B3). Credits: FRIPON - link
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Figure 11 — Pictures of the accessory components of the mounting system for the all-sky camera. From left to
right: bolts, nuts and rings to fix the camera support (M4 bolts - small ones, B4a) and the pole mounting
support (M5 bolts - big ones, B4b), two pole mounting rivets (B5), junction box (B6), and a female-to-female
Ethernet RJ45 coupler.
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C. Control mini-PC

The mini-PC included in the Meteor Camera Kit has the following specifications:

DELL OptiPlex Micro Form Factor
(producer code 08XD1, EAN: 5397184800867)

® Processor Intel i5-13500T
e 8 GBRAM

e Storage 256 GB SSD, custom upgraded to 1 TB SSD before shipping (KINGSTON NV2
SSD 1 TB M.2 NVME 2280 PCIE 4.0)

e Operating Systems: Windows 11 Pro (from factory), Debian GNU/Linux 11 (installed
before shipping)

e 1l-year warranty

The mini-PC is pictured in Figure 12. It comes with its own power supply adapter, whose
specifications are highlighted in the figure to avoid confusion while installing the kit. Figure
13 illustrates all the ports on the front and back of the mini-PC.

Figure 12 — Pictures of the Mini-PC included in the StAnD Meteor Camera Kit. From left to right: the Mini-PC
in display mode (C), its power supply adapter (C1) and the specifications of the power adapter.
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Figure 13 — Pictures of the front (top panel) and back portion (bottom panel) of the Mini-PC with ports and
buttons highlighted.
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D. Network Switch
The network switch included in the Meteor Camera Kit has the following specifications:

DLINK - Smart Switch Gigabit 10P GIGABIT 8 ports PoE + 2 Mini-GBIC
(producer code DGS-1210-10P, EAN:0790069467721)

e 8 ports 1000Base-T 802.3af/802.3at PoE
® 2 SFP ports

® 65 W PoE Budget

® Fanless

The switch is pictured in Figure 14. It comes with its own power supply adapter, whose
specifications are highlighted in the figure to avoid confusion while installing the kit. Figure
15 illustrates all the ports on the front and back of the switch.

Figure 14 — Pictures of the network switch included in the StAnD Meteor Camera Kit. From left to right: the
network switch in display mode (D), its power supply adapter (D1) and the specifications of the power
adapter.
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Figure 15 — Pictures of the front (top panel) and back portion (bottom panel) of the network switch, with
ports highlighted. The red box highlights the LED panel, with one LED for each Ethernet port (1 - 8). Each LED
flashes a steady green light when the corresponding port is connected to a device via an Ethernet cable. Ports

9 and 10 are SFP ports and will not be used in the current configuration.
5 —
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E. Ethernet Cables

The Ethernet cables to connect the all-sky camera, mini-PC, and network switch are included
in the Meteor Camera Kit. They are shown in Figure 16. In particular:

e 2 m Ethernet cable Cat5e to connect the mini-PC to the network switch (E1);

e 5 m Ethernet cable Caté (LZSH fireproof) to connect the all-sky camera to the
network switch (E2);

e A waterproof RJ45 Ethernet coupler (E3) to join the 5 m Ethernet cable to the short
one embedded in the case of the all-sky camera.

The detailed connection scheme is shown in Figure 8. An additional Ethernet cable is
required to connect the network switch to the Ethernet wall plug (not included in the kit).
No particular technical requirements apply to this cable.

Figure 16 — Pictures of the Ethernet cables included in the StAnD Meteor Camera Kit. From left to right: the 2
m CAT5e cable to connect the mini-PC to the switch (E1), the 5 m CAT6 fireproof cable to connect the all-sky
camera to the network switch (E2), and the waterproof RJ45 Ethernet coupler used to join the Ethernet
cables to the all-sky camera (E3).
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Figure 17 — The cardboard box used to deliver the StAnD Meteor Camera Kit by mail. Credits: N-3 srl - link

F. Packaging
The whole kit is delivered by mail in a cardboard box with a StAnD branded sleeve (Figure
17), with internal bubble wrap padding to protect the hardware from damage during

shipping.

3. Installation Guide
This chapter covers the installation of the StAnD Meteor Camera Kit. The process can be
subdivided into four main steps:

1. Verification of the technical requirements;

2. Assembly and installation of the all-sky camera mounting system (B);

3. Installation of the all-sky camera (A) and connection to the room where the control
mini-PC and network switch will be located (and, if necessary, installation of the
electrical junction box);

4. Installation of the control mini-PC (C) and network switch (D) and connection to the
Internet network;

5. First boot of the Meteor Camera Kit.

3.1. Technical Requirements

The following technical requirements have to be taken into account when identifying the
location where the StAnD Meteor Camera Kit will be installed.

3.1.1. Camera Positioning

The all-sky camera should be installed on the roof of a building, preferably without
prominent obstacles within its FoV (i.e., down until the visible horizon). Therefore, the
building should be the tallest in its proximity.
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Figure 18 — Checking the sky quality classification according to the Bortle Dark Sky Scale on World Atlas 2015
for the Astrophysical Observatory of Torino, located on the hills East of Torino in the municipality of Pino
Torinese. The site is classified as class 6 (bright suburban area), with a naked-eye limiting magnitude between
5 and 5.5 mag. These conditions are enough to ensure that the StAnD Meteor Camera Kit can work properly.
Sites classified as class 8 or 9 should be avoided. Credits: Light Pollution Map, World Atlas 2015 - link
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The last 10° above the horizon are usually not very important due to light pollution, which
prevents the detection of stars (and even meteors unless very bright) in this region. Small
obstacles (such as chimneys, antennas, flags etc..) close to the camera are not a deal breaker
(a workaround is possible by masking them via software) but should be avoided.

3.1.2. Light Pollution

The StAnD Meteor Camera Kit can work properly even in light-polluted sites near large and
medium-sized cities. This is because the observation targets are bright objects (fireballs and
bolides).

To check the sky quality at your installation site, please refer to the Light Pollution Map -
World Atlas 2015. For optimal observations, one should avoid installing the kit in areas
classified as 8 or 9 on the Bortle Dark Sky Scale, identified by the colors white to light violet
on the World Atlas 2015. You can check this value by left-clicking on your position on the web

map (see Figure 18).

Of course, installation sites with lower light pollution are preferable. More importantly, you
should ensure that there are no direct light sources (such as light poles, signs...) pointing
towards the camera or producing diffuse light in its vicinity (~50 m from the camera).

3.1.3. Camera Mounting
The mounting system of the all-sky camera can be adapted for installation on a flat surface
(e.g. a rooftop terrace), an inclined surface (e.g. a roof), or on a pole (see Section 3.2).
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Mounting on a pole must be avoided if there are other viable solutions. In this case, the
camera will be more susceptible to vibrations caused by wind.

The camera should be levelled (parallel to the ground), and the mounting should be as
stable as possible (both for hardware integrity and for calibration stability).

3.1.4. Mini-PC and Network Switch Positioning

The mini-PC and network switch must be installed inside a building (protected from the
weather). The Ethernet cable connecting the all-sky camera and switch (E2) can be a
maximum of 20 metres long (otherwise, the connection delay between the camera and the
PC becomes too high), and the one included in the kit is 5 m long.

Therefore, another Ethernet cable of up to 15 m in length can be added, using the junction
box and the RJ45 coupler included in the kit (Figure 11, B6 and B7).

3.1.5. Internet Connection and Power Supply

There must be an Internet connection and at least two power sockets available in the room
where the mini-PC and network switch are installed. The electrical grid should guarantee
continuity of the power supply. If either the mini-PC or the network switch is disconnected,
the kit will stop working.

The network switch must be connected to the Internet via a stable connection; high speed is
not required, but stability is more important to ensure a constant connection to the central
servers. The Internet connection must be delivered by an Ethernet cable to the network
switch. If this is not possible, an Ethernet dongle with a WiFi antenna (WiFi/Ethernet bridge
- example) can be used. The network you are using to provide Internet access to the switch
must have a DHCP server (Dynamic Host Configuration Protocol) available to assign the IP
address to both the mini-PC and the all-sky camera.

3.1.6. Tools Required for the Installation
e one Phillips screwdriver;

® a7 mm wrench to assemble the all-sky camera mounting system;
e 4to 8 wall plugs to install the all-sky camera mounting system;
[ ]

a standard Ethernet cable to connect the network switch to the building’s wired
Internet connection.

3.2. Installation of the Mounting System of the All-sky Camera

3.2.1. Assembly
The mounting system for the all-sky camera (B) can be assembled in several configurations,
depending on the features of the installation site, as shown in Figure 19:

1. Installation on level ground is the preferred option, if a flat and level surface is
available on the rooftop of your building;

2. When installing the mounting system on a wall, you should make sure that said wall
does not obstruct the camera’s FoV,
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3. When installing the mounting system on an inclined surface, pay particular attention
to levelling the system during installation (See Section 3.2.2).

Figure 19 — The assembly options for the mounting system of the all-sky camera included in the StAnD
Meteor Camera Kit. From left to right: on level ground (e.g. terrace), on a wall (top of the side wall of the
building), and on an inclined plane (e.g. roof). Credits: FRIPON - link

Step 1 - After identifying the suitable configuration, assemble the mounting system as shown
in Figure 19. Mount the two side panels (B2) onto the main body of the system (B1) in the
desired position. Use four M4 bolts, nuts and rings (B4a) per side panel, tightening them
with the 7 mm wrench.

The mounting system can also be installed on a pole, as shown in Figure 20. Do not choose a
long mounting pole. The longer it is, the more prone it will be to oscillations caused by wind
and vibrations, which can disrupt the measurements and damage the hardware inside the
camera. For pole mounting, follow steps 1a and 2a.

Step 1a - If necessary, attach the pole mounting plate (B3) to the mounting system. Use M5
bolts, nuts and rings (B4b) to attach B3 to the bottom of the side panels (B2). In this case,
the mounting system must be assembled in the same way as for wall mounting (b). Then,
mount the two rivets (B5) onto the pole and fix them to B3, as shown in Figure 20. Use the 7
mm wrench to tighten all bolts.

Figure 20 — A scheme of the pole mounting system for the all-sky camera included in the StAnD Meteor
Camera Kit (left) and a picture of the system correctly mounted (right). Credits: FRIPON - link

NS
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3.2.2. Installation of the Mounting System
At the time of installation, check the following (see also Section 3.1):
e The upper side of the camera mounting system must be horizontal. Check this with a
spirit level;
e The camera mounting system must be installed so that the horizon is as clear as
possible;
e The camera mounting system must be firmly secured and should not move, even in
case of strong winds;
e Avoid elements of obstruction , in particular moving ones (e.g. flags, chimneys,
antennas), that could create noise in the images captured by the camera;

e Avoid direct urban lighting, which may come from lights right above the camera or
unshielded lights in its surroundings, because of the risk of reflections on the
objective lens;

e If needed, the junction box must be installed within reach of the 5 m Ethernet cable
connected to the all-sky camera.

Step 2 - Secure the assembled mounting system to the floor (Figure 19a), to the wall (Figure
19b), or to the roof (Figure 19c). Use 4 - 8 wall plugs (2 - 4 per side) to fix the two side panels
(B2). The holes on B2 are suitable for M5 screws. Use the Phillips screwdriver to tighten the
screws.

Step 2a - For pole mounting (Figure 20), fix the two side panels (B2) to the pole mounting
plate (B3) using 4 - 8 M5 bolts (2 - 4 per side), nuts and rings (B4b). Use the 7 mm wrench to
tighten the bolts.

3.3. Installation of the All-sky Camera

During the installation of the all-sky camera (A), pay very close attention not to scratch the
camera dome. Remove the protective film only as the final step of the process, after the
installation of the camera has been completed. The protective case is hermetically sealed
with desiccant to prevent condensation forming inside. Therefore, the camera module must
not be opened.

At this stage, the aim is to install the camera on its support and to route the Ethernet cable
to where the control mini-PC (C) and network switch (D) will be located.This part of the
installation is therefore carried out outdoors, while the next steps will take place entirely
indoors.

The camera support and the protective case have a dozen holes to allow the camera to be
oriented towards the North (within approximately 15°). Before the installation of the
camera, verify the direction of North in order to position the camera accordingly (see Figure
21).
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Figure 21 — A picture showing the correct orientation of the all-sky camera of the
StAnD Meteor Camera Kit towards the North. The camera’s protective case has two
vertically arranged bolts pointing outwards (marked with the red line in the
picture), which attach the camera module to the interior of the case. Due to the
internal arrangement of the components, the bottom portion of the CMOS is
always facing this direction. Therefore, by aligning this direction towards the North,
an approximate reference frame can be defined a priori, allowing all cameras in the
network to share the same approximate orientation.

Step 3 - After identifying the North direction and the closest orientation of the camera to
match it (See Figure 21), secure the all-sky camera module (A) to its support of the
mounting system (main body, B1) using at least three M4 bolts, nuts and rings (B4a).
Depending on the installation, it may be easier to remove the camera support to secure the
camera to it and then reposition it afterwards. The short Ethernet cable attached to the
camera module must pass through the central hole of B1.

Finally, the Ethernet connection from the camera module must be routed inside the
building to the room where the mini-PC and network switch will be installed.

Step 4 - After securing the camera module to its support, install the waterproof RJ45
Ethernet coupler (E3), connecting one side to the short Ethernet cable coming from the
camera module, to join with the 5 m Cat6 Ethernet cable (E2; see Figure 16). Then, secure
the Ethernet cable to the pole, floor, or roof (depending on your installation configuration) in
accordance with the safety requirements of your building. The cable must reach the room
where the mini-PC and network switch will be installed.

3.3.1. Installation of the Junction Box

It may happen that the provided 5 m Ethernet cable (E2) is not long enough to reach the
room where the mini-PC and network switch will be installed. In this case, there are two
options to solve this problem.

The first option is to replace the provided Ethernet cable with a longer one that can reach
the said room. When doing so, make sure that the new cable meets the requirements (Cat6,
suitable for outdoor installation, LZSH fireproof). It can be up to 20 m in length.

Otherwise, a junction box (B6) is provided and can be mounted outdoors to extend the
Ethernet cable provided in the kit by up to an additional 15 m. The junction box is used to
protect the junction between the two Ethernet cables by means of the female-to-female
Ethernet RJ45 coupler (B7).

The junction box must be installed in a place that can be reached using the 5 m Ethernet
cable included in the kit. It should preferably be vertically fixed (on a wall). At least two
screws are required on the inside of the junction box in order to secure it to the wall. In
order to prevent rainwater infiltration, the junction box must be placed so that the holes
through which the cables pass face downwards (see Figure 22). All holes (both for fixing the
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junction box to the wall and for routing the cables) are sealed and must be pierced with
scissors or a screwdriver either before or during the installation.

Figure 22 — Pictures showing the correct installation of the junction box (B6) included in the StAnD Meteor
Camera Kit, used to extend the 5 m Ethernet cable with an additional one. The junction box must be installed
vertically and the cables are to be inserted through the bottom holes, to prevent water infiltration. Credits:
FRIPON - link

Step 4a - If needed, install the junction box (B6) in a vertical position (e.g. on a wall) at a
location within 5 m of the camera module. Remove the top panel (by unscrewing the 4
screws at the corners) and use at least two wall screws with plugs (not provided) to secure
the box to the wall. After piercing the two bottom holes of the junction box, insert the two
Ethernet cables (E2 and the extension cable) into the junction box and connect them using
the female-to-female Ethernet RJ45 coupler (B7) as shown in Figure 22.

3.4. Installation of the Mini-PC and Network Switch

Provided that the Ethernet cable from the camera module now reaches the room where the
rest of the Meteor Camera Kit hardware will be located, it is now time to install the control
mini-PC (C) and the network switch (D). Both components are almost self-installing. The two
main steps are the connection of both components to the power supply and the Ethernet
connection through the network switch (see Figure 23).

Step 5 - Connect the control mini-PC (C) and the network switch (D) to the power supply
through their respective power adapters (C1 and D1, be careful not to mix them). Both
plugs of the power adapters must be inserted into their respective power inputs (see Figure
13 and Figure 15). The power LEDs on both devices will start blinking. If the mini-PC’s power
LED does not blink after a few seconds, press the power button. The network switch does
not have a power button and it always turns on when plugged into the power socket.
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Step 6 - Three Ethernet cables must be connected to the network switch. The order of the
ports is not relevant but, with reference to Figure 23:

e port 1 - Ethernet cable coming from the Ethernet wall plug (delivering the building’s
Internet connection);

e port 3 - Ethernet cable (E1) connecting the mini-PC to the network switch;
® port 5 - Ethernet cable (E2) coming from the camera module installed outside.

If a port is plugged in and communication via the Ethernet cable is working properly, the
corresponding Ethernet LED (see Figure 15) will be turned on with a green (the port is
running at 1000 Mbps) or orange/amber (10 or 100 Mbps) light, and blinking when data is
being transferred. LEDs 3 and 5 should always be green, while LED 1 may be orange if the
building’s Internet connection is slower. This is not an issue. However, if LEDs 3 and/or 5 are
orange, there might be some issues with the Ethernet cable installation. If any LEDs do not
light up, try reconnecting the cable and switching the corresponding device off/on.

Finally, to check if the camera module is correctly powered via PoE, press the “Mode” button
on the front of the network switch for about 1 second (see Figure 15). LEDs 1 and 3 should
be turning off, while only LED 5 should remain on with a green light. This indicates that the
power supply to the camera module is stable and functioning correctly. To go back to the
previous LED configuration, press the “Mode” button again.

Figure 23 — Desk installation of the StAnD Meteor Camera Kit (top panel), along with connection specifics
(bottom panels). For this installation, the Ethernet cables are plugged into the network switch as follows
(bottom left panel): the Internet network is connected to port 1, the Ethernet cable from the mini-PC to port
3, and the cable from the camera module to port 5. LEDs 1, 3 and 5 of the network switch are correctly lit
(bottom centre panel) and, when pressing the “Mode” button, only LED 5 remains on (bottom right panel),
all with green light. An orange/amber light might indicate a slower connection. Notice that, of course, the
camera module must be installed outdoors as shown in Section 3.1.1.
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3.5. First Boot of the StAnD Meteor Camera Kit

If everything has been installed correctly, the StAnD Meteor Camera Kit is already working
and no further action is required regarding the hardware components.

The final crucial point is to check the Internet connectivity of the kit, ensuring that it is
correctly communicating with the central PRISMA servers. To do so, it is best to get in touch
with your StAnD representative. For more details on how to connect to the StAnD Meteor
Camera Kit locally and remotely, please refer to Section 4.1.3.

All components are configured to automatically switch back on in the event of a power
shortage, or when unplugged from the grid to be relocated somewhere else. However, it is
best to always check the status of the LEDs after performing these operations and, if
needed, force the reboot of the mini-PC by pressing the power button. For further
information regarding the maintenance of the kit, please refer to Section 4.3.

The software might require some additional intervention to complete the installation after
the first boot.

Step 7 - To ensure the correct connectivity and operability of the StAnD Meteor Camera Kit,
you should get in touch with your IT department (i.e. the person in charge of managing the
Internet network in your building) and ask them to open the following ports of the firewall:

1) port 1194 / UDP (OpenVPN protocol), used for the VPN (Virtual Private Network)
connection to the central server of PRISMA;

2) port 80 / TCP (HTTP protocol), used to access the StAnD Meteor Camera Kit through
its web browser interface;

3) port 443 / TCP (HTTPS protocol), used to deliver the updates to the Kkit.

Depending on when you received the kit, some software updates might be required to
ensure its full functionality. Get in touch with your StAnD representative to know more and
schedule the intervention, if needed.

4. User Guide

This chapter aims to discuss how to access the StAnD Meteor Camera Kit on your local
network and remotely, how to operate the kit through the provided user-friendly browser
interface, how to access the data recorded by the kit and by the entire StAnD network, and
how to maintain the hardware and software to ensure the best preservation and operability
of the kit over time.

Within the PRISMA and StAnD network, each kit (i.e. each station or node of the network) is
uniquely identified by a station code. An example of such a code is “ITPI01”, in which:

e IT stands for the country (e.g. Italy);
e Pl stands for the region (e.g. Piemonte);
e 01 is a progressive number assigned to the stations in that region.
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Alongside the code, each node is also identified by a station name, usually referring to the
city or village where the station is located. For example, the PRISMA station ITPIO1 is also
called “PinoTorinese”.

4.1. How to Access the StAnD Meteor Camera Kit

The StAnD Meteor Camera Kit can be accessed by connecting to the mini-PC, which is the
“brain” of the whole system. Knowing the IP address of the Mini-PC, access can be made
from another PC, laptop, or mobile device through any web browser via a user-friendly
interface. There are two IP addresses from which the mini-PC can be reached:

e The local IP address, i.e. the address of the mini-PC within the local network of the
building, to which the mini-PC is connected via the Ethernet cable passing through
the switch from the Ethernet wall plug.

e The VPN IP address of PRISMA, i.e. the address through which the PRISMA server
reaches the mini-PC. This address never changes but is accessible only if you have
access to the PRISMA VPN yourself.

An IPv4 address is a 32-bit number (for example, 192.168.1.1) divided into four octets (192,
168, 1 and 1). The first three octets refer to the “network class” (i.e. 192.168.1). Very roughly
speaking, the devices plugged into the Ethernet ports in the same room (e.g. classroom)
should all share the same network class.

4.1.1. Finding the Local IP Address of the mini-PC

The StAnD Meteor Camera Kit can be reached via the local IP address only from the local
network, i.e. if the user’s computer is connected to the same network as the mini-PC. Be
aware that this IP address can vary over time (from a couple of hours up to a few days) if the
local network is managed through a DHCP server (dynamic IP), or it can be a fixed IP address
(static IP). To determine whether the kit will have a dynamic or static IP address, it is best to
ask the IT department or person responsible for your building or institution.

If the mini-PC is assigned a static IP, you can ask your IT department directly to provide you
with this address once and for all. Within the network, they might be able to identify the
machine by the station code assigned to your kit. When online, the mini-PC will always be
reachable through that static IP address.

In either case, to find out the local IP address of the mini-PC, you can perform the following
steps:

1. Plug your computer (e.g. a laptop) directly into the network switch or into an
Ethernet port within the same network class (usually in the same room; see above)
using an Ethernet cable. You might not have Internet access this way; this is not a
problem.

2. Find out the IP address assigned to your computer. To do so, on Microsoft Windows
OS v. 10/11, go to Settings > Network & Internet > Ethernet, scroll down to the
bottom of the page and search for the entry Address IPv4. Otherwise, open Windows
Terminal (or Windows PowerShell), type ipconfig /all, press Enter and search for the
entry Ethernet Adapter EthernetO / IPv4 Address. If you have a Linux or Mac
computer, open a Terminal window, type ifconfig, press Enter and search for eth0 /
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inet. Write down this address. Let us say that the IP address you have found is:
192.168.137.124

3. Download Advanced IP Scanner from the official website (it might be available in
your language as well). Install the program on your laptop by following the installer's
instructions, and start the program (see Figure 24).

4. Enter into the textbox under the Scan button the first three octets of your laptop’s IP
address, adding the full range for the last octet: 192.168.137.1-255, and press Scan.
Wait about 1 minute to let the program complete the network scan.

5. Once the scan is complete, you will have a list of all the devices connected to that
network. If you plug directly into the StAnD network switch, you should find a few
devices. Otherwise, you may find many. See Figure 25 for an example of such a list
displayed on the program.

6. Search for the entries that have a small arrow on the left side of the IP address.
Those are the machines that you can access. Left-click on them. One of them should
display the code of your StAnD node (e.g. ELATO1 in Figure 25). That is the IP address
of the mini-PC in your local network. You can copy it by right-clicking on the
corresponding line and selecting Copy > IP.

Figure 24 — Starting window of the Advanced IP Scanner program, showing instructions on how to search for
the IP address of the StAnD mini-PC connected to the local network.

P Manufacturer MAC address Comments

2) Press Scan

Status

Type your IP address minus the last octet, and replace it with
1-255. Example: 192.168.137.1-255

0 alive, 0 dead, 0 unknown
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Figure 25 — The result of the network scan searching for the StAnD mini-PC connected to the local network
using the Advanced IP Scanner program. To identify the IP address of the mini-PC, look through all the entries
with a small arrow on the left side of the IP and right-click on them. One of them should display the code of
your StAnD node (e.g. ELATO1 in this figure). In this case, its IP address is 192.168.137.249.
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4.1.2. Connecting to the PRISMA VPN Remotely

If you have access to the VPN of the PRISMA network, you can reach the mini-PC remotely
from your laptop, provided that you have an Internet connection (which does not block VPN
services). The use of this service is limited to 1 / 2 accesses per StAnD node. Contact your
StAnD representative for more information about this service and to submit a request.

Once your request is approved, you will receive a VPN certificate (.ovpn file). Do not share
your certificate with anyone. Then, follow these steps:

1. Install OpenVPN Connect client. You can download the installer from the official
website. Install the program on your laptop by following the installer's instructions,
and start the program.

2. Launch OpenVPN Connect and select Upload File. Then, browse to the .ovpn file that
you received and select it, then click Connect. The imported profile will be saved, and
you will be connected to the VPN (see Figure 26).

3. To disconnect from the VPN, click on the slider. The next time the client is launched,
the imported profile will be there and you will just need to click on the slider again.
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Figure 26 — The interface of the OpenVPN Connect client used to connect to the PRISMA VPN, showing the
main steps for the first installation. Import the .ovpn file and click Connect. The imported profile will be
saved and, the next time you launch the client, you will just need to click on the slider to connect and
disconnect from the VPN.
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If the VPN connection fails, it is most likely because the Internet connection that you are
using blocks external VPN services. Contact your IT manager.

Once you are connected to the VPN, to know the IP address of your StAnD mini-PC, ask your
StAnD representative. This address will never change.

4.1.3. Accessing the mini-PC Locally or Remotely

If you have access to the VPN of the PRISMA network, or you are connected to the local
network where the StAnD mini-PC is connected, open a web browser, type the mini-PC’s IP
address into the address bar and press Enter. If the connection is successful, the login page
of the StAnD Meteor Camera Kit will be displayed (see Figure 27).

If you do not know your login credentials yet, get in touch with your StAnD representative.
There are two levels of authentication:

® Guest credentials: the user can access, view, and download the data acquired by the
kit;

e Admin credentials: the user has all the privileges of a guest user but can also
configure and operate it (turn it on and off, reboot, start, and stop acquisitions) and
modify the login credentials of authorised users.

You can select the language in the top right corner of the page. Enter your credentials and
press Log in. If nothing happens, you have probably entered the wrong credentials.

Any web browser should work fine. However, the best performance is usually provided by
the Morzilla Firefox web browser.
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4.2. Browser Interface Description

Once logged in, the browser will display the StAnD Meteor Camera Kit homepage (see Figure
28), which presents the main functionalities of the kit. The elements of the homepage are as
follows:

e Statistics of total detections, last month’s detections and today’s detections;
Map showing the station position;

Latest detected image;

Tables of station data and today’s detections;

Summary of node status (error log and VPN connection status);

Data usage (CPU, RAM and storage of the mini-PC);

Sidebar menu options:

o Users (user management area) - available to admin only;
Containers status (FreeTure execution) - available to admin only;

FreeTure configuration (configuration updates) - available to admin only ;
Maintenance (reboot option) - available to admin only;

Calibrations (calibration data) - available to admin and guest;

Stacks (stacks data) - available to admin and guest;

o O O O O O

Detections (meteors data) - available to admin and guest.
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Figure 28 — The homepage of the StAnD Meteor Camera Kit web browser interface, illustrating the
operational status of the kit. The sidebar menu options link to the other web pages within the interface. Only
the last three are available to guest users (to download the data), while they are all available to admin users.
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Figure 29 — The Users page of the web browser interface for the StAnD Meteor Camera Kit (only available
when logged in as an admin). The green textbox is shown as an example of the confirmation message that
the user should receive after a successful operation (e.g. changing a user’s password).
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In the following sections, the functionality of the kit is described by illustrating the content of
the web pages accessible via the sidebar menu options.

4.2.1. Users
This page is available only when logged in as an admin. See Figure 29 for an example.

It allows modification of user passwords (both guest and admin). To do so, select the user
whose password you want to modify. Press the Modify button that pops up near the Change
password title, then enter and confirm the new password, and press Confirm. Wait for a
confirmation message (in a green textbox) to pop up in the top right corner of the screen.
Otherwise, select Cancel to undo the ongoing change.

4.2.2. Containers Status
This page is available only when logged in as an admin. See Figure 30 for an example.

It allows monitoring and modification of the execution status of the FreeTure container,
which is the program that runs and controls the whole operability of the kit (acquisition
schedule, trigger for meteor detection, etc.). It can monitor the status of the container under
the List section. The status can be:

e Up - the FreeTure container is running;

e Exited - the FreeTure container is paused (the data acquisition is stopped);

° - the FreeTure container is rebooting (recently restarted or rebooting to
load a configuration change; see Section 4.2.3).
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Figure 30 — The Containers status page of the web browser interface for the StAnD Meteor Camera Kit (only
available when logged in as an admin).
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You can start, stop or restart the container using the three buttons available on the right
side of the status column. After pressing the corresponding button, wait for a confirmation
message (in a green textbox) to pop up in the top right corner of the screen. For example,
you might want to stop the execution of the FreeTure container if you plan to perform
maintenance on the camera installation without unplugging the whole kit.

Under the FreeTure logs section, the user can monitor the details of the last operations
performed by the kit, and download the log by clicking the Download button.

4.2.3. Freeture Configuration

This page is available only when logged in as an admin. See Figure 31 for an example.

It allows modification of the configuration parameters of the FreeTure program running on
the kit through three sections.

The first section is Load file and allows modification of the whole configuration file, using
the option Upload new FreeTure configuration file, and uploading a new mask file, using the
option Load new mask. The first option should be used for debug purposes only and by
skilled users (it requires manual modification of the field in the config file but may cause
FreeTure to crash if not configured correctly). On the other hand, the second option is used
to upload for the first time or modify the mask used by FreeTure to filter false positives at
the horizon of the all-sky camera (see Section 4.3.1). For both options, select a new file with
the dedicated button, press the Load button on the right side of the file textbox and wait for
a confirmation message (in a green textbox) to pop up in the top right corner of the screen.
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Figure 31 — The FreeTure configuration page of the web browser interface for the StAnD Meteor Camera Kit
(only available when logged in as an admin).
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In the second section, Automatic configuration, you can modify the most important
parameters of the kit:

e Station name and code: please do not modify these entries by yourself. If you think
they are wrong, contact your StAnD representative first;

® Observer: the name of the person responsible for the kit;

e Altitude: the altitude above sea level of the all-sky camera installation site, measured
in metres;

e Longitude: the geographic longitude of the all-sky camera installation site, measured
in decimal degrees (E), with at least 4 - 5 decimal digits;

e Latitude: the geographic latitude of the all-sky camera installation site, measured in
decimal degrees (N), with at least 4 - 5 decimal digits;

To modify one or more parameters, click the Modify button and edit the corresponding
fields. Once all changes have been made, press Save and wait for a confirmation message (in
a green textbox) to pop up in the top right corner of the screen.

At the first installation, verify the geographical coordinates using a GPS (the typical accuracy
of a smartphone should be sufficient; otherwise, check the position on Google Maps). If you
need to move your camera, contact your StAnD representative first, then change the
coordinates on this page.

The last section is Manual configuration and allows modification of all the parameters
contained in FreeTure’s configuration file. The table can show 10 - 100 elements at once and
provides an overview of the parameters, their corresponding values and a short description
for each parameter. When first delivered, the camera will already be configured for normal
operating conditions. Any modification of these parameters (apart from those listed in the
Automatic configuration section) may disrupt the operation of the camera, and the user
assumes responsibility for any modifications performed.

4.2.4. Maintenance

This page is available only when logged in as an admin. It allows rebooting of the whole
system by clicking the (only) red button Start the reboot. You will need to log in again to the
browser interface once the reboot is complete. Be aware that a reboot might change the
local IP address if it is managed as dynamic.

4.2.5. Calibrations
This page is available to both admin and guest. See Figure 32 for an example.

It allows previewing and downloading of the calibration data (also called captures), which
are images taken with the camera exposed for 5 seconds every 10 minutes during the day
and night. Captures are acquired because the exposure time of the meteor videos
(detections; see Section 4.2.7) is not enough to capture stars, which are needed to perform
the astrometric and photometric calibration of the camera.

The first section, List, of the page displays two interactive tables that allow browsing through
the calibration data. The first table displays acquisitions from the last 10 days (you can scroll
back in time using the page Back / Next buttons) and the number of captures acquired each
day. A regularly functioning camera should acquire about 144 captures per day.
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Figure 32 — The Calibrations page of the web browser interface for the StAnD Meteor Camera Kit (available to
both admin and guest users).
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By clicking on an entry in the first table, you select that particular day and all the captures
acquired during that day are displayed in the second table on the right. Each entry shows the
name of the image (in .fit format), the time of acquisition, and two buttons to preview and
download the image.

The preview must be enabled beforehand using the dedicated slider on top of the table. You
can download the preview (.png format) by right-clicking on the image in the browser and
selecting the Save image option. Since the previews are generated on request and make use
of some of the mini-PC’s computational power to be produced, it is strongly recommended
not to generate previews during night-time. Preview generation can be disabled by the
admin (see Section 4.3).

The second section of this page, Last calibration, displays a preview of the latest capture
acquired by the camera.

Captures are stored on the mini-PC for about two months. After this time, they are deleted
to free up disk space for new acquisitions. If the station is properly connected to the
network, captures are continuously synchronised to the PRISMA servers, where they are
stored and processed.

4.2.6. Stacks
This page is available to both admin and guest. See Figure 33 for an example.

It allows previewing and downloading the stack data, which are data generated by stacking
(i.e. summing) the images acquired by the meteor detection algorithm (30 fps; see Section
4.2.7) over a period of 1 minute. Therefore, each stack image is the sum of 1800 frames.

The layout of this page is the same as that of the captures data (see Section 4.2.5).

Figure 33 — The Stack page of the web browser interface for the StAnD Meteor Camera Kit (available to both
admin and guest users).
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You can download the preview (.png format) by right-clicking on the image in your browser
and selecting the Save image option. Since the previews are generated on request and make
use of some of the mini-PC’s computational power to be produced, it is strongly
recommended not to generate previews during night-time. Preview generation can be
disabled by the admin (see Section 4.3).

Stack images are saved to provide live-time feedback on what is happening within the
camera’s FoV, but they are not included in the scientific processing. Therefore, they are not
synchronised with the PRISMA servers. Stacks are stored on the mini-PC for about two
months and then deleted.

4.2.7. Detections
This page is available to both admin and guest. See Figure 34 for an example.

It allows previewing and downloading the detection (meteor) data, which are videos of
meteors captured by the FreeTure software. As already mentioned, the camera operates
continuously at 30 fps to check for the passage of meteors within its FoV. This is done by an
automatic trigger software operating within FreeTure, which checks (during night-time) for
the presence of fast-moving bright sources in subsequent images in the 30 fps video stream,
which may be meteors or fireballs. In such a case, FreeTure saves the portion of the video in
which the meteor was detected.

The layout of this page is similar to that of the calibration and stack data pages. The first
section, List, allows browsing through the list of detections recorded each day. For each
detection, you can preview and download the following:

® Preview: an integrated image of the video, on which the meteor track should be
visible (see Figure 35, top panel);

e DirMap: an image with dots indicating the estimated and approximated position of
the meteor within each frame during the video, computed by the trigger algorithm
(see Figure 35, bottom left panel);

e GeMap: a black-white image indicating the region of the frame where the meteor
was detected by the trigger algorithm (see Figure 35, bottom right panel);

e Video: a video of the meteor generated by the browser interface in .mkv format;
® Zip: the data of the meteor detection acquired by FreeTure in .fit format.

You can download the preview (.png format), DirMap and GeMap (.bmp format) by
right-clicking on the image in your browser and selecting the Save image option. The preview
generation can be disabled by the admin. Additionally, the download of video and zip files
must be activated by the admin (see Section 4.3). Since the previews and videos are
generated on request and make use of some of the mini-PC’s computational power to be
produced, it is strongly recommended not to generate previews and download videos and
zip files during night-time.

As this is an automatic system, detections may contain false positives, that is, a detection
may be caused by other natural or artificial events occurring within the camera’s FoV. For
example, the lights of a car passing by may trigger a detection on the horizon of the camera
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at a particularly dark observational site, if not filtered by the application of a mask (see
Section 4.2.3 and Section 4.3.1).

Detections are stored on the mini-PC for about two months. After this time, they are
deleted to free up disk space for new acquisitions. If the station is properly connected to the
network, detections are continuously synchronised to the PRISMA servers, where they are
stored and processed.

The second section of this page, Last detection, displays a preview of the latest detection
captured by the camera. On the right side, you can also see a graph showing the number of
detections made during the last few days.

Figure 34 — The Detections page of the web browser interface for the StAnD Meteor Camera Kit (available to
both admin and guest users).
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Figure 35 — An example of preview images for a detection made by the FRCA20 - Nice camera of the StAnD
network on the 13th of January 2025 at 22:20:12 UT. The top panel displays the meteor track from an
integrated image of the video, while the bottom panels display the DirMap (left) and GeMap (right) bitmaps,

on which the approximate position of the meteor detected by the trigger algorithm can be visualised.
NICE 20250113T222032 UT
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4.3. Maintenance of the Kit

4.3.1. Detection Mask

After the first boot of the StAnD Meteor Camera Kit, once you have verified that the kit is
correctly connected to the Internet (see Section 3.5), you will need to update the detection
mask to minimise the number of false positives detected by the FreeTure trigger software
(see Section 4.2.3 and Section 4.2.7). Such detections are caused by various artificial sources
and typically occur at the horizon of the FoV, for example due to flickering lights or cars
passing by during night-time.

An increased number of false positives in the detection dataset might cause the mini-PC’s
HDD to fill up faster than two months, resulting in a lower performance of the kit and in a
shorter timespan before data are locally deleted from the mini-PC.

Depending on the configuration parameters (see Section 4.2.3), FreeTure may fail to start
properly without a mask being uploaded. In this case, if you wish to start the operation of
the kit regardless, log in to the browser interface, go to FreeTure configuration and change
the parameter ACQ_MASK_ENABLED to false (under the Manual configuration section of
the page). Remember to set this parameter back to true after uploading the mask.

The detection mask must be an 8-bit black-white .bmp image with the same resolution as
the frame acquired by the camera. In this image, the black portion indicates the region
where triggers should be excluded by FreeTure, while the white portion marks the region
where the software will look for triggers.

The detection mask needs to be uploaded after the first installation of the kit, if you move
the camera installation position or if you modify its orientation. To do so:

e you can ask your StAnD representative to do it for you;

e |[f you wish to do it yourself, you can download a night-time capture preview from
the browser interface and use it to create your own mask. You can modify it by using
any image manipulation program, such as GIMP. You can follow these steps:

1. After installing this software, launch it and select Flle > Open from the menu
bar, then select the downloaded .png capture preview;

2. You can use the Free Selection (Lasso) tool to highlight the area to be masked
(i.e. the border of the horizon to be masked; see Figure 36);

3. Once you are done, press Enter and sharpen the border of the selection
(Select > Sharpen from the menu bar) and fill it with white colour using the
Bucket Fill tool;

4. Then, invert the selection (Select > Invert from the menu bar) and fill it with
black colour using the Bucket Fill tool;

5. Go to Image > Mode from the menu bar and select Grayscale mode, then
again, go to Image > Precision and select Integer 8-bit;

6. To export the image, go to File > Export as to save the image, select the .bmp
format and save it on your computer;

7. Finally, you can upload it through the browser interface (as admin) and, if
needed, reset the FreeTure parameter ACQ_MASK ENABLED to true in the
Manual configuration of the FreeTure configuration page (see Section 4.2.3).
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Figure 36 — An example of the detection mask for the StAnD camera FRCA20 - Nice. The left panel highlights
the border that was selected in GIMP to define the masked region, while the right panel shows the final
result (where the white portion of the image marks the region where triggers are possible, and the black part
represents the excluded region). Notice that the upper-right horizon in the image is masked with a thicker
margin due to intense light from a street lamp. Additionally, the lights from cars passing in that direction
were found to be triggering false positives during night-time.

After modifying the detection mask, you can monitor whether the camera is frequently
detecting false positives during night-time via the browser interface. If so, you can adjust the
mask - for example, by raising the border above the horizon to mask additional pixels and
exclude the region that is causing such false positives.

4.3.2. Software Monitoring

To ensure the best operational status of the StAnD Meteor Camera Kit, you should
periodically check the functionality of the software by logging into the browser interface (as
admin) and check the status of the following pages (at least every 10 - 15 days if possible):

e On the homepage, check for any errors reported under the Node status section. If
any errors are detected, report the issue to your StAnD representative.

e On the Containers status page, check whether the FreeTure container is up and
running. If not, check for errors in the log and try to restart the container. If this
attempt fails, report the issue to your StAnD representative.

e On the Calibrations and Stack pages, check whether data are being acquired
regularly every day. You should see about 144 captures per day and about 1440
stacks per day. If you see lower numbers, report the issue to your StAnD
representative.

e |[f needed, you can disable the display of the preview and the download of video
and zip files. In order to do so, go to the homepage and, from the user menu in the
upper-right corner, select Settings. Both options can be enabled or disabled under the
Media View section.
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4.3.3. Hardware Monitoring
To ensure the best operational status of the StAnD Meteor Camera Kit, you should
periodically check the hardware status of the kit (at least every 10 - 15 days if possible):

1. Check the condition of the protective plastic dome of the all-sky camera. Water
droplets are not a problem, especially during summertime. If you see some dirt piling
up on the dome, clean it very gently with a wet microfiber cloth, trying not to alter
the orientation of the camera.

2. Check the status of the Ethernet cables (and junction box, if installed) that are
exposed to atmospheric agents. A degraded Ethernet cable may not be able to
withstand the data traffic, especially the one connecting the all-sky camera module to
the mini-PC.

3. Check the status of the mini-PC and network switch. They should be powered on,
with all cables correctly plugged in, and displaying the correct lights on their front
panels (see Section 3.4). If you know that the power went down in your building,
check whether the mini-PC is back on; if not, power it on by pressing the power
button on its front panel (see Figure 13).
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